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The File Menu
Commands in this menu allow you to select/deselect files to erase. For help on any of the 
items in this menu, select it from the following list.

Select Alt+F,S Display the File Select cascading menu which provides tools for 
selecting files.

DeselectAlt+F,L Display the File Deselect cascading menu.
Exit Alt+F,X Close the drive window and exit from SmartErase.



File Exit Command
Closes SmartErase's drive window and exits. You can also exit by double-clicking the 
application Control-menu box or pressing Alt+Spacebar,C.



The Configure Menu
This command displays a Configure SmartErase dialog box which lets you choose 
SmartErase options, including what types of files to protect and how often to purge. It also 
lets you temporarily disable and enable SmartErase protection.
Note: SmartErase configuration options are saved automatically when you click on OK.



The Help Menu
Commands in this menu provide help on using SmartErase and access to the standard 
Windows help-for-help information. 

Index Alt+H,I Index to the SmartErase help system.
Keyboard Alt+H,K Quick reference to keystrokes for SmartErase.
Commands Alt+H,C Menu commands. You can also get help on a particular menu item by 

selecting it and then pressing F1.
ProceduresAlt+H,P Common procedures and general topics.
Using Help Alt+H,U How to use the Windows help system. You can press F1 now to see 

this help file.
About... Alt+H,A Product name, copyright, credits, and version of this program.



Configure SmartErase Dialog Box
This dialog box lets you control the amount of deletion protection provided by the SmartCan 
program. SmartErase works in conjunction with SmartCan to protect and recover deleted 
files. If SmartCan is not installed, SmartErase still can recover most files.
Enable SmartErase Protection

When checked, SmartErase tracks file deletion operations, making it possible to recover 
deleted files with 100% accuracy. When unchecked, deleted files are not protected, but it 
is often possible to recover files if you use SmartErase quickly.
When this check box is dimmed, it means that the SmartCan TSR program has not been 
loaded into memory. To ensure file protection, you should load SmartCan from your 
AUTOEXEC.BAT file.

Files To Protect
These options allow you to specify what types of files to protect. Customize the settings to 
suit your needs.
All files (*.*): Select this option button for full protection of all files.
Only the files listed: To protect only certain types of files, select this option button then 

enter the desired file extensions in the File Extensions text box.
All files except those listed: To protect all files except for those you designate, select 

this option button then enter file extensions in the File Extensions text box.
Protect archived (backed up) files: When unchecked, files which have been backed up 

(and have not changed since the last backup) are not protected. SmartErase assumes 
you can recover them from the backups.
When checked, protection is provided only for files which have NOT been backed up (or 
have changed since the last backup). Files which have NOT been backed up are shown 
with a file attribute of a in the drive windows.

File Extensions: Enter one or more file extensions, separated by spaces or commas.
A common way to configure SmartErase is to select the All files except those listed 
option button, then enter: BAK, OLD, OBJ, TMP, SWP in the File Extensions text box to 
disable protection on these types of files.

SmartErase Storage Limits
SmartErase requires disk space for its SMARTCAN sub-directory. SmartCan uses this hidden
directory to temporarily store deleted files until they are automatically or manually 
purged. As long as the disk space used by the protected files is not needed, you can 
recover deleted files with 100% reliability.
Purge files held over [ xxx ] days: Check this check box and enter a number to set a 

time limit on the file protection. Entering a smaller number minimizes the SMARTCAN 
disk usage. The default is 5 days. When unchecked, only the Kbytes limit applies.

Hold at most [ xxx ] Kbytes of erased files: To allocate a maximum amount of disk 
space to the SMARTCAN directory, check the Hold at Most check box and enter a number
in kilobytes. When the SMARTCAN reaches this limit, SmartErase purges files as 
necessary to make room, starting with the files it has protected for the longest period. 
The minimum limit is 16K.
Note:You may want to leave this check box unchecked and simply specify a time limit. 

Deleting a large file (thereby adding it to the SMARTCAN directory) can cause 
many files to be purged at once. If you become short on disk space, you can 
always purge files manually by clicking the Purge button on the SmartErase drive 
window button bar.

Drives to Protect
Highlight the hard disk drive(s) you wish to protect. Click on a drive to select or deselect it.

OK
Click this or press Enter to confirm the option settings. Changes take effect immediately 



and are saved and used as the default.
Cancel

Click this or press Esc to exit the dialog box without saving any changes.



SmartErase Button Bar Commands
The button bar at the bottom of the SmartErase drive window provides the following 
commands:
UnErase Recovers the files that are currently highlighted in the drive window. If the file 

being recovered was not stored in the SMARTCAN, the UnErase dialog box will 
prompt you for the first letter of the filename.

Purge Purges deleted file tracking data displayed in the current SmartErase drive 
window (this frees up disk space).

Show Old (toggles to Hide Old) Displays all of the deleted file information that is in the 
directory, including duplicate directory entries and entries that were deleted 
months ago. In the normal Hide Old mode, only recent file deletions are 
displayed.

Help Displays the Help Index for this file.
The status area on the right side of the button bar shows how much deleted file data is in 
the SMARTCAN directory and the percentage of the allocated space that is currently in use.
Notes: The maximum size of the SMARTCAN directory is set via the Configure SmartErase

menu command.
The nKBytes value is the amount of disk space that is freed if you use the Purge 
button.



UnErase Dialog Box
This dialog box allows you to specify the first letter of the file to UnErase. The ? character is 
where you need to supply at least the first letter of the name of the file to be recovered.



Norton SmartErase Keys
Use the following keys in Norton SmartErase:
Ctrl+click Add file/directory to disjoint selection.
Shift+click Extend selection to this item.
Shift+drag Extend selection (rather than drag and drop).
Tab Move keyboard focus to next pane or control.
Shift+Tab Keyboard focus backward one pane or control.

Select file/directory below or to the right.
Select file/directory above or to the left.

Shift+
 

Extend selection.
Ctrl+/ Select all.
Ctrl+\ Deselect all except current item.
Home Select top file/directory.
End Select bottom file/directory.
PgDn; PgUp Scroll list by one screenful; select top or bottom item.
Shift+F8 Start/stop disjoint selection mode.
Spacebar Select or deselect item (in disjoint selection mode).
F1 Help.
Alt+F4 Exit.



Norton SmartErase Procedures
Using Norton SmartErase
Recovering Erased Files
How SmartErase Protects Files
Installing the SmartCan TSR
Working with Drive Windows



Using Norton SmartErase
While Norton Desktop is running, drag files you wish to delete to the SmartErase tool icon. 
Note:To provide maximum protection for your files, (and to give SmartErase the best chance

of recovering deleted file data), be sure to install the SmartCan program before 
starting Windows. See Installing SmartCan.

Norton SmartErase works in three modes:
As a command in the Norton Desktop Tools menu: Choose the Tools UnErase 
command (Alt+T,U) to display a SmartErase drive window and begin recovering erased 
files.

 As a tool icon on the Norton Desktop: To delete files, open a drive window, select the 
files or directories to delete and drag and drop them into the SmartErase tool icon. 
SmartErase prompts you to confirm the action.
Or double-click the tool icon to bring up the SmartErase drive window to recover deleted 
files.

 As a stand-alone application: If Norton Desktop is not running, you can launch 
SmartErase by double-clicking on its icon in a Quick Access or Program Manager group 
window. Or you can use the File Run command with the command line SMTERASE.EXE.
Related Topics:

Installing the SmartCan TSR
Recovering Erased Files
Permanently Deleting Files



How SmartErase Protects Files
SmartErase is the display and recovery portion of a dynamic duo of erasure protection. It 
works with a TSR (terminate and stay resident) program called SmartCan, which remains in 
memory, tracking each file which is deleted.
Instead of actually deleting files, SmartCan transfers their information into a hidden sub-
directory named SMARTCAN located in the root directory of each hard disk drive. This 
prevents the deleted files from being overwritten - so the data is 100% protected.
Later, after some pre-determined interval or when the maximum amount of storage is 
reached, SmartCan releases the deleted file's data area for reuse by other files.
Even if SmartCan is not installed, SmartErase can often recover deleted files. It depends 
upon how fragmented the file was and whether you have written new file data over the 
erased file.
Related Topics:

Installing the SmartCan TSR
Recovering Erased Files
Permanently Deleting File



Recovering Erased Files
The best time to recover a deleted file is immediately after the deletion takes place. If a file 
was deleted some weeks ago, some or all of its data may have been overwritten by other 
file data.
To recover an erased file:
1 Start SmartErase from the Tools UnErase command in the Norton Desktop menu, or by 

double-clicking its icon in your Norton Desktop Applications group window.
2 Choose the tree pane of SmartErase's drive window to view the directory of the deleted 

file.
3 Examine the filenames in the file pane. The deleted file may be listed with a question 

mark (?) as its first character. Move the highlight to the file of interest.
4 Use the View View Pane command to inspect the file's data area.
5 Click the UnErase   button   on the button bar to recover the file.
6 Next, verify the data in the recovered file by trying to load it into the application which 

created it.
In some cases, you might recover only a portion of a file, especially if you're trying to 
recover a file deleted some time ago or a file deleted when SmartCan was not running.
If it appears that part of the file is corrupted or missing:
*  Exit Windows and run UNERASE.EXE from the Fix-It Disk.

UnErase can collect bits and pieces of lost file data and may even salvage the entire file.



Installing the SmartCan TSR
The program SMARTCAN.EXE is located on the Fix-It Disk of Norton Desktop for Windows. It
is a TSR; that is, a program which after it has been executed remains in memory and 
continues to perform. When installed and enabled, it tracks all file deletions and ensures 
that you can recover deleted files with 100% accuracy.
SMARTCAN.EXE must be loaded before you start Windows. It is commonly loaded from your 
AUTOEXEC.BAT file.
To load SmartCan from AUTOEXEC.BAT:
1 Start the Desktop Editor (or any text editor) and open the file C:\AUTOEXEC.BAT.
2 Insert the line SMARTCAN /ON /SKIPHIGH into the file.
3 Save the AUTOEXEC.BAT file.
4 Exit from the editor and Windows.
5 Reboot your computer by pressing Ctrl+Alt+Del.

Next time you use Norton Desktop, select the Configure SmartErase command to verify
that SmartCan is active. The Configure command also allows you to modify various 
SmartCan options.

Note:If you already use the DOS 5.0 program MIRROR.EXE and install its deletion tracking 
TSR (via Mirror /T), then you should consider switching over to SMARTCAN.EXE. 
Although SmartErase can use the deletion-tracking file that is created by Mirror, you'll 
receive better protection if you use SmartCan in conjunction with SmartErase.



Purge: Permanently Deleting Files
While SmartCan is installed, deleted files are not immediately purged. Instead, the file's 
directory entry is temporarily moved to a hidden directory named SMARTCAN in the root 
directory of the hard drive.
These entries remain in the SMARTCAN directory until a pre-determined amount of time has 
elapsed or a file-tracking limit is reached. You can set the file limit and deletion delay via the
Configure command or the Norton Desktop Configure SmartErase command.
Since files actually remain undeleted for some period of time, you may find that even if you 
do housekeeping -- deleting unwanted files -- you may still not free up much disk space.
To reclaim the deleted file disk space, start SmartErase and click the Purge button on the 
button bar. Do note, however, that purging the directory removes your chance of ever 
recovering the purged files.



Using Drive Windows
Norton Desktop provides drive windows which allow easy access to your data.
To open a drive window:
* Double-click its drive icon.

Or,
* Choose the Window Open Drive Window command.

To select more than one file:
* Press Ctrl while clicking each file.

Or,
* Click one file, then press Shift while clicking another, to select all files between the two.

Or,
* Choose the File Select Some command to select by wildcards.

Or,
* Press Shift while clicking a file to select all between two clicks.

See Selecting Files for related information.
To view many files in the file pane:
* Choose the View File Details command and uncheck everything except for Icon. This 

results in a multiple column file display.
Or,

* Increase the size of the drive window via its Maximize button.
To quickly move to a directory in the tree pane:
1 Give the tree pane the keyboard focus by clicking it or pressing Tab a few times (its 

borders darken).
2 Type the first few characters of any directory name.

Or,
Type one character and press  to find the next match.

To perform global disk housecleaning:
1 Choose the View Show Entire Drive command.
2 Choose the View Sort by Type command and look for .BAK, .OLD, and other targets for 

deletion. Ctrl-click to select them.
3 Choose the View Sort by Size command and Ctrl-click large, unneeded files.
4 Choose the View Sort by Date command and Ctrl-click obsolete files.
5 Choose the View Sort by Name command and Ctrl-click unneeded duplicate files.
6 Press Delete to delete the unwanted files.

To copy files:
1 Highlight the files to copy.
2 Open another drive window, if you want to copy between drives.
3 Drag and drop the selection.

Hint: You can drop files right into a drive icon.
To delete files:
1 Highlight the files to delete.
2 Press Delete.

Or,
Drag the selection into the SmartErase tool icon.

To close a drive window:
* Double-click its Control-menu box.

Or,
* Press Ctrl+F4.



SMARTCAN
* This is a special directory in the root of each drive. It is created and maintained by the 

SmartCan program. When you erase a file, it is moved into this directory and the 
SmartErase utility can recover the file with 100% reliability. Old files in the smartcan 
directory are deleted periodically to free up disk space.

* The SmartErase tool icon works as a "smart file delete." When you drag a file into the 
icon, the file is deleted, but is fully recoverable.



The SmartCan Program
SmartErase (a.k.a UnErase) is able to recover deleted files with 100% accuracy only when 
the SmartCan program has been installed in memory before you start Windows.
The SmartCan program is named SMARTCAN.EXE. It is a TSR (terminate and stay resident) 
program which remains in memory and tracks file deletions transparently to DOS and 
applications.
For best results, install SMARTCAN.EXE by placing the command SMARTCAN /ON /SKIPHIGH in
your AUTOEXEC.BAT file. To check if SmartCan is enabled or to set its options, select the 
Configure SmartErase command from the Norton Desktop Menu.



Expandable/Collapsible Tree

This method of displaying your directory structure lets you expand and collapse branches of 
the directory tree in the tree pane. To expand a branch, double-click a  folder. To collapse, 
double-click a 

 folder.
When using expandable/collapsible trees, you may experience short delays as Norton 
Desktop reads the disk for directory information. To switch to a faster method of tree display,
uncheck the Use Collapsible Tree menu item on the Tree menu.



Using Expandable/Collapsible Tree Displays
Norton Desktop features two methods of displaying and utilizing directory tree displays. To 
toggle between the two methods, choose Use Collapsible Tree from the Tree menu. When
this menu item has a check mark to its left, expandable/collapsible trees are enabled in all 
drive windows and Standard Browse... dialog boxes.

When using expandable/collapsible trees, you never need to refresh the tree display, but you
may have to wait for short periods as Norton Desktop reads your disk for directory 
information.
Initially, the tree is mostly collapsed, displaying only directories that are at the same level as
the current directory.
To expand a branch:
* Double-click the  icon.
* Or, select the branch and press + (plus) on the numeric keypad.
* Or, choose the Tree Expand One Level command.
To expand all branches:
* Press Ctrl+* (asterisk)
* Or, choose the Tree Expand All command.

To collapse a branch:
* Double-click the  icon.
* Or, select the branch and press - (minus) on the numeric keypad.
* Or, choose the Tree Collapse Branch command.





Standard Browse Dialog Box
Whenever a Norton Desktop application prompts you to enter a filename, you can click 
Browse and use the handy dialog box which appears to find the file (and avoid typing a long
pathname).
Directory

This line displays the current default or currently-selected directory. This text changes 
automatically when you select from the Drives and Tree list boxes.

File
* Type the filename and press Enter.
* Or, select a file from the Files list box.
* Or, type a wildcard file specification and press Enter to see only files matching that 

wildcard. You can type multiple wildcards, separating them with a comma (for example, 
*.WK?,*.XLS).

* Or, select from the List Files of Type drop-down list box to display only files matching a 
listed wildcard.

When you click OK, the selected filename is appended to the text in the Directory line 
and the result is returned to the parent dialog box.

Files
This list shows the names of files in the current directory, in alphabetical order.
* You can type the first few characters of a filename to quickly scroll to that part of the list.

Press  to find other matches.
* Or, use the scroll bar to look through this list. You can double-click a filename to 
select it and automatically confirm the dialog box.
Tree
* You can type the first few characters of a directory name to quickly scroll to that part of 

the list. Press  to find other matches.
* Or, use the scrollbar to look through this list. When you click a directory, its files are 
shown in the Files list.

Note: If the Tree display is expandable/collapsible, some directories may not be 
listed. To expand or collapse a directory, double-click its folder icon. See Using the 
Expandable/Collapsible Tree Display for related information.

Drives
* You can type a drive letter.
* Or, click the prompt button (or press Alt+ ) and use the scrollbar to look through this 

list. When you select a drive, its directories will be listed in the Tree list.
Refresh

Use this button to refresh the listings in the Tree and File lists. This is needed when you 
change diskettes in a floppy-disk drive, or after you've created a directory or file from a 
DOS window or another application.

OK
Click this button, or double-click a filename, or press Enter to confirm your selection of 
drive, directory, and filename. The combined full file specification will be used as input for 
the dialog box from which this Browse dialog box originated.

Cancel
Exits the dialog box without selecting a file.



Standard Directory Browse Dialog Box
Whenever a Norton Desktop application prompts you for a directory name, you can click the 
Directory button, and use this handy dialog box to locate the directory.
Drive

Enter a drive letter. Or, click the prompt button (or use Alt+  to display the drop-down list 
box containing available drives and select a drive from the list. The Tree list box is 
refreshed and displays all of the directories on the selected drive.

Tree
* Type the first few characters of a directory name to quickly move to that part of the list 

box. Press  to find other matches.
* Or, use the scroll bar to look through this list box. When you select a directory, its 
files are shown in the Files list box.

Note: If the Tree display is expandable/collapsible, some directories may not be 
listed. To expand or collapse a directory, double-click its folder icon. See Using the 
Expandable/Collapsible Tree Display for related information.

OK
Click this button, or press Enter to confirm your selection of drive and directory. The result
is used as input for the dialog box from which this Browse dialog box originated.

Cancel
Exits the dialog box without selecting a directory.





Viewer Dialog Box
This dialog box lets you choose a file viewer from among those that are installed on your 
system.
Current or Default Viewer

Select a viewer from the list box. Use the scroll bars to display additional viewer names. 
Click OK.

Norton Viewer (or the view pane of a drive window) automatically uses one of these viewers 
each time you open a file for viewing. The viewer used is based on the file's extension.
See Viewer File Types for a summary of applications, file types, and extensions associated 
with each viewer.
See Associating a Viewer to a File Type for information on how to tell Norton Viewer which 
viewer to use for an uncommon file extension or to force the use of a viewer other than the 
default viewer assigned to a supported file type.



Find Dialog Box
Use this dialog box to locate a specific string in the Viewer window. When viewing 
spreadsheet or database files, use it to specify what part of the document you to search.
Find

Type the text you want to find into the text box.
Match Upper/Lowercase

Check this check box if you want Norton Desktop to find an exact match. When cleared, an
UPPERCASE string is considered a match with a lowercase or MixedCASe string.

Where to Search
This group box appears when the active window contains a spreadsheet or database file. 
First select one of the option buttons:
Entire Document:  When this option button is selected, the entire spreadsheet or 

database file is searched.
Partial Document, starting at:  When this option button is selected, the two text boxes 

below indicate the starting row (record) and column (field) where the search is to begin. 
The search includes the specified location, plus all columns and rows that are to the right
of and below it.

Column (or Field):    When this option button is selected, only text in the specified column
(or database field) is searched. This is ideal for searching records of a database file to 
locate, for example, a specific customer name or city. If you are viewing a spreadsheet, 
enter a value in the text box or use the spin buttons to select a value. If you are viewing 
a database file, click the prompt button and select an item from the drop-down list box.

Row (or Record) When this option button is selected, only text in the specified row (or 
database record) is searched.

OK
Click this button or press Enter to begin the search.



Goto Dialog Box
This dialog box appears when you choose the Goto command while viewing a spreadsheet 
or database file. It lets you specify the address of a cell or database record you want to view.
With a large spreadsheet or database this may be faster than using the scroll bars to move 
through the file.
Column (or Field)

Specify a spreadsheet column or a database field.
If you are viewing a database file, click the Prompt button or press Alt+  to display the 
drop-down list box. Or, type the first character of any item in the list to move to that item. 
If you are viewing a spreadsheet, enter a value in the text box or use the spin buttons to 
locate the desired value.

Row (or Record)
Specify a spreadsheet row or a database record number.



Norton Viewer File Types
The default viewer for a particular file type depends on settings in the NDW.INI file.
See Associating a Viewer with a File Type for related information.
Note: You may have viewers not in the list below, or some viewers listed here might not be 

installed on your system. In addition, the viewer filenames may be different from those
shown here. This list shows a representative sample. Actual viewer names and 
filenames are found in the [Viewer-Parser] section of the NDW.INI file.

Documents & Text (DOC.PRS)
Microsoft Word & Word for Windows .TXT .DOC .SYS .BAT
WordPerfect (5.0 & above)
Amí & Amí Pro
Any ASCII text file

Spreadsheet
Lotus 1-2-3 (L123.PRS) .WK1 .WKT .WKS
Quattro .WKQ .WQ1
Microsoft Excel (EXCEL.PRS) .XLS

Database (DBASE.PRS)
dBASE and compatibles .DBF

Graphics
Tagged Image (TIFF.PRS) .TIF
Compuserve (GIF.PRS) .GIF
Windows Bitmap (BMP.PRS) .BMP
Paintbrush (PCX.PRS) .PCX
Icons (ICO.PRS) .ICO .NIL .DLL .EXE
WordPerfect Image (WPGI.PRS) .WPG

Compressed Archives (ZIP.PRS)
PkZip; PkPak .ZIP .PAK
Sea Arc, Zoo, Lzh .ZOO .ARC .LZH

Programs (PROG.PRS) .COM .DLL .EXE
DOS Executables
Windows Executables .DLL .EXE

Hex Dump (HEX.PRS)
Any binary file

Portions of graphics viewers Copyright © 1990-92 Halcyon Software, Inc. All rights reserved.



Associating a Viewer with a File Type
When you open a file for viewing, Norton Viewer checks the file's extension and selects a 
viewer that is associated with that extension. The topic Norton Viewer File Types lists the 
standard extension-to-viewer associations.
Note: Regardless of the default viewer used for a file, it is always possible to select a 

different view parser.
You can add to the viewer association list or modify some part of it. For example, you may 
want to display .EXE files as a hex dump or you may want to add .C and .H to the extensions
associated with the Documents & Text viewer.
Viewer associations are set up in the NDW.INI file and can be modified using Desktop Editor 
or any standard text editor. To add or modify an association:
* Use Desktop Editor or Notepad to open NDW.INI from your Windows directory.
* Look for the section labeled [Viewer-FileMap]. Lines in this section are in the form:

ext= viewer [viewer]
where ext is a file extension and viewer is the name of a view parser program. Additional
viewers (if any) are used only if the first viewer cannot understand the file's format.

* Add a new association by inserting a line in this section. The names of the view parsers 
are listed in NDW.INI under the [Viewer-Parser] section.

* Save changes to the NDW.INI file and restart Norton Desktop to put the changes into 
effect.





Select Cascading Menu
These commands are available in the File menu, under the Select menu item.

All Alt+F,S,A (or Ctrl+/) Highlights (selects) all displayed files in the active file pane.
Some Alt+F,S,S (or Ctrl+S) Displays a Select Some dialog box which lets you highlight 

a subset of the displayed files--those that match a specified wildcard.
InvertAlt+F,S,I Inverts the current selection; that is, all highlighted files are deselected and

all others are selected.
This can be very handy. For example, if you want to select all files 
except .DOC files, choose Select Some to highlight all .DOC files, then 
choose Select Invert to deselect the .DOC files and highlight all other files.

Related Topics:
Selecting Files
Using Drive Windows
File Pane Display Options



Deselect Cascading Menu
These commands are available in the File menu, under the Deselect menu item.

All Alt+F,L,A (or Ctrl+/) Highlights (selects) all displayed files in the active file pane.
Some Alt+F,L,S Displays a Deselect Some dialog box which lets you deselect a subset 

of the displayed files--those that match a specified wildcard.
Invert Alt+F,L,I Inverts the current selection; that is, all highlighted files are deselected 

and all others are selected.
Related Topics:

Selecting Files
Using Drive Windows
File Pane Display Options



The View Menu
Commands in this menu provide drive window display options and options for viewing the 
contents of selected files. For help on any item in this menu, select it from the list.

Tree Pane Alt+V,T Show or hide the tree pane.
File Pane Alt+V,F Show or hide the file pane.

View Pane Alt+V,V Show or hide the view pane.
Show Entire Drive Alt+V,E Show all files on drive in the file pane. Closes tree pane.

Refresh Alt+V,R Read the disk and update display.
File Details Alt+V,D Choose how much information to show for each file.

Filter Alt+V,L Include or exclude files from display.
Font Alt+V,N Choose a font typeface and point size for drive window panes.

Sort By Alt+V,S File pane sort options.
Viewer Alt+V,WView pane commands (search for text, choose viewer, etc.).



View Tree Pane Command
Shows or hides the tree pane portion of the active drive window.
When the tree pane is open, you can select an entire directory or subtree and drag and drop 
it onto a tool icon, another drive window, or into a different part of the same tree pane.
Note: It is possible for Norton Desktop to be unaware of recent changes to your directory 

tree. You may need to use the View Refresh command to rescan the disk and get an 
updated, accurate picture.

Related Topics:
Using Drive Windows



View File Pane Command
Shows or hides the file pane portion of the active drive window.
When the file pane is open, you can select one or more files and drag and drop onto a tool 
icon, another drive window, a directory of the tree pane of the same drive, or directly onto 
the desktop to create a desktop item icon.
Tip: To see a multiple-column display of files in this pane, choose the View File Details 

command and clear all check boxes except Icon.
Related Topics:

Using Drive Windows



View View Pane Command
Shows or hides the view pane portion of the active drive window.
When the view pane is open, the contents of the currently selected file in the file pane are 
displayed.
Note: Commands in the View Viewer cascading menu are disabled unless a view pane is 

open.
Related Topics:

Using Drive Windows



View Show Entire Drive Command
When checked, all the files on the drive are displayed in the file pane. When unchecked, only
the files in the selected directory are shown.
Note:In all cases, only the files which match the filter criteria are shown. Choose the View 

Filter command to specify which files to display and which to "filter out."
This command is handy for disk housecleaning, as you can:
* Find duplicate files in more than one directory (Sort by Name)
* Find large files when trying to reclaim disk space (Sort by Size, Descending)
* Find unwanted files, such as all files that have an extension of .BAK, .OLD, etc. (Sort by 

Type)
Related Topics:

Using Drive Windows
File Pane Display Options



View Refresh Command
This command updates the tree pane and file pane by scanning the selected drive and 
displaying the most recent information.
Norton Desktop maintains a file (TREEINFO.DT in the root directory of the drive) that 
describes each drive's directory structure. If you use a DOS command line to add or remove 
directories, the information in this file can become out-of-date.
Thus, you may need to use the View Refresh command occasionally to make sure that 
Norton Desktop is displaying accurate directory and file information. Incidentally, if you use 
NCD (the Norton Change Directory program of the Norton Utilities) to rescan your disk, its 
information is used by Norton Desktop to maintain an accurate tree file.
Note: If you prefer, you can display directory information using expandable/collapsible 

trees. Each time you expand or collapse a directory, Norton Desktop reads directly 
from your drive and provides you with an up-to-date picture of the contents. See Using
Expandable/Collapsible Trees for details.

Related Topics:
Using Drive Windows
Missing Directories?



View Filter Command
This command displays a Filter dialog box which lets you select the types of files you want 
displayed (or filtered out) of the file pane of the active drive window. You can specify a filter 
using wildcard file specification or by file attribute.
When you enable a filter, the drive window title bar changes to describe the filter.
Tip: When the message "No Files Found" is displayed in a file pane, it really means no files 

match the filter criteria. You may want to reset to an All Files filter as soon as possible 
to avoid confusion.
The filtering affects directory drag and drop operations. For instance, when you drag a 
directory into the Shredder, only the unfiltered files (those that are displayed) are 
shredded.

Related Topics:
Using Drive Windows
File Pane Display Options



View File Details Command
This command displays a File Details dialog box which lets you determine which file attribute
information you want displayed in the file pane.
You can hide the directory names that are normally shown in the file pane; they are 
displayed in the tree pane, if open.
Tip: To see a multiple-column display of files in this pane, choose the View File Details 

command and clear all check boxes except Icon.
Related Topics:

Using Drive Windows
File Pane Display Options



View Font Command
This command displays the Font dialog box which lets you select the font to be used in the 
different parts of a drive window.
Tip: When viewing program source code and other text files created in DOS text mode, a 

monospaced font such as Terminal or Courier best portrays a text mode display. 
Furthermore, a small size such as 8 point or 9 point helps display more information in 
the window.

Related Topics:
Using Drive Windows
Font Dialog Box



View Sort By Cascading Menu
These commands are available in the View menu, under the Sort cascading menu. Use 
these options to specify the order in which filenames appear in the file pane.

Name Alt+V,S,N Sort by filename.
Type Alt+V,S,T Sort by file extension; puts same-type files together.
Size Alt+V,S,S Sort by file size; use to look for large files.
Date Alt+V,S,D Sort by date and time; use to look for old or new files.

Unsorted Alt+V,S,U Display as found in the directory on the disk.
Ascending Alt+V,S,A a,b,c,...z (or small...large or old...new).
Descending Alt+V,S,D z ,y,x...a (or large...small or new...old).
Related Topics:

Using Drive Windows
File Pane Display Options



View Viewer Cascading Menu
These commands are available in the View menu, under the Viewer menu item. They are 
enabled only when the view pane is open.

Find Alt+V,V,F Activate the Find dialog box to search for text in the view pane.
Find Next Alt+V,V,N Locate next occurrence of found text.

Find Previous Alt+V,V,P Locate previous occurrence of found text.
Goto Alt+V,V,G Activate the Goto dialog box to display the file at a specified row 

and column (when viewing a spreadsheet).
OEM Text Alt+S,O Display the file contents using the OEM character set instead of 

the ANSI character set (active when checked).
Change Viewer Alt+S,G Activate the Set Viewer dialog box to select a different 

viewer to display the file.
Hint: For a comprehensive search of many files, you can use Norton SuperFind (choose Find

from the File menu) to scan through files.
Related Topics:

Using Drive Windows



Select Some or Deselect Some Dialog Box
This dialog box appears when you choose the File Select Some and File Deselect Some 
commands. It lets you quickly select (or deselect) files in a file pane by using wildcards.
Tips: Files not included in the wildcard specification are still displayed, but not selected. If 

you want to see only certain types of files, choose the View Filter command.
For help with making disjoint selections, see Selecting Files.

File
Enter one or more wildcard file specifications, separated by spaces or commas. For 
instance, entering *.WK?,*.XLS selects all Lotus 1-2-3 and Excel spreadsheet files.
Or, click the prompt button (or press Alt+ ) to display a drop-down list containing 
previously used wildcard file specification sets. Select an item from the list box.

OK
Click this button (or press Enter) to save your settings and close the dialog box.



Filter Dialog Box
This dialog box appears when you choose the View Filter command. Use it to specify the 
types of files you want displayed in the file pane.
You can specify a filter using wildcard file specification and/or file attributes. Using a filter is 
a convenient way to locate and collect a group of files, such as all files ending with .BAK, 
files which are hidden or files which have not been backed up.
Tip: When the message "No Files Found" is displayed in a file pane, it really means no files 

match the filter criteria. You may want to reset to an All Files filter as soon as possible 
to avoid confusion.
The filtering affects directory drag and drop operations. For instance, when you drag a 
directory onto the Shredder, only the unfiltered files (those that are displayed) are 
shredded.

File Type
Select an option button:
All Files:    All filenames are included under this option -- there is no filtering on filename 

or extension.
Programs:  Only files having an extension of .EXE, .COM, and .BAT are displayed.
Documents:  Only files having an extension of .DOC and .TXT are displayed.
Custom:  Select this option if you want to see only those files matching wildcard file 

specifications. Enter one or more file specifications, separated by spaces or commas. For
instance, entering *.WK?,*.XLS filters out all files except for Lotus 1-2-3 and Excel 
spreadsheet files.
Or, click the prompt button or press Alt+  to display a drop-down list box containing 
previously used file specifications. Select an item from the list box.

Attributes
Choose settings for the three-state check boxes. The three selectable states are:

(grayed) Ignore the attribute.
(checked) Filter-out files that don't have the attribute.
(cleared) Filter-out files that do have the attribute.

Read Only (Can't be deleted or modified) When checked or grayed, files tagged as read 
only are included in the display.

Archive (Needs to be archived) When checked or grayed, files which have not been 
backed up are displayed.

Hidden When checked or grayed, hidden files are displayed.
System When checked or grayed, system files are displayed.

Show Directories
When checked, subdirectories are shown in the file pane along with files.
When unchecked, only files appear in the file pane.

Set Default
If you want the same filter specifications to be used each time you open a new drive 
window, select the desired filter options, then click this button. The settings you specify 
take effect for the currently active drive window and all subsequently opened drive 
windows. By default, Norton Desktop displays all files.

OK
Saves your settings and closes the dialog box.

Note:These settings are part of the Norton Desktop configuration and can be saved as the 
defaults for future sessions.



File Details Dialog Box
This dialog box appears when you select the View File Details command. Use it to specify 
the file attributes to be shown in the file pane of a drive window. You can display many files 
at once, in a three, four or five column list.
Details

Check the check boxes containing the attributes you want displayed in the file pane.
Tips: To display files in a multi-column format, clear all but the Icon check box.

To see the maximum number of files, disable the tree and view panes and maximize 
the drive window.

Icon When checked, a small icon appears to the left of each filename. The icon visually 
represents the type of file. It is one of the following:

Executable program or batch file
Text file or word processor document
Generic document (data file)
Directory

Size When checked, the file size is displayed.
Date and Time When checked, the date and/or time that the file was created or most 

recently modified is displayed.
Tip: The format used to display time and date (leading zeros, AM/PM vs. 24-hour, etc.) is

a system-wide setting you change from the Windows Control Panel (CONTROL.EXE).
Double-click the International item to display the International dialog box.

Attributes When checked, the file attribute codes are displayed. Any of the following 
codes may appear:
r Read only: The file cannot be deleted or modified.
a Archive: Needs to be archived. The file has not been backed up since it was created

or last modified.
s System: Special support file used by DOS. The file usually has the Hidden attribute.
h Hidden: Not displayed when you use the DOS DIR commands.

Directory When checked, the name of the file's directory is displayed.
Tip: Some of the file details can extend past the right edge of the file pane. To see the 

Attributes and Directory details, you may need to enlarge the file pane.
Sample

This area shows an example file entry that corresponds to the check boxes you have 
checked in the Details group box.

Set Default
If you want the same file details to be displayed each time you open a new drive window, 
check the appropriate check boxes, then click this button. The settings you specify take 
effect for the currently active drive window and all subsequently opened drive windows. By
default, Norton Desktop displays only the file's icon.

OK
Saves your settings and closes the dialog box. The settings take effect for the currently 
active drive window.



Font Dialog Box
This dialog box appears when you select the View Font command. Use it to select a font 
typeface, style and point size to use in the panes of a drive window.
Font

Select a font from the combo box.
Font Style

Select a style. By default, "Regular" is selected.
Size

Choose a font size, in points. The combo box displays the available sizes of pre-generated 
bitmap fonts. For TrueType and other scalable fonts, standard point sizes are listed, 
although the list is not exhaustive.

Panes
Check one or more check boxes. The font settings affect only the selected panes:
Tree and File:  Settings apply only to the tree pane and file pane.
View:  Settings apply only to the view pane.
Tip: To choose different settings for different panes, use this dialog twice, checking only 

one of the check boxes each time.
Sample

This area shows an example of the font in the currently-selected style and size.
Apply to All Open Drive Windows

Check this check box if you want these settings to be used in all other open drive windows.
If checked, the settings are saved as part of your desktop configuration.
If unchecked, the settings apply to just the active drive window.

OK
Saves your selections and closes the dialog box. The settings affect the active drive 
window.



File Pane Display Options
You have considerable control over the file pane display.
To view a multiple-column list of files:
1 Choose the View File Details command.
2 Clear all check boxes except Icon.
3 Click OK.

To sort the files:
1 Open the View Sort By cascading menu (Alt+V,S).
2 Select a sorting option; Name, Type (i.e., extension) Date (and time) or Size.
3 To view the files in reverse order, choose the View Sort By command again and select 

Descending (Alt+V,S,D).
To view ONLY files matching a wildcard:
1 Choose the View Filter command.
2 Select the Custom option button.
3 Enter one or more wildcard file specifications, separated by spaces or commas.
4 Click OK.
Tip: When the message "No Files Found" is displayed in a file pane, it really means no files 

match the filter criteria. You may want to set the filter to All Files to avoid confusion.
To view all files on a disk (great for disk housecleaning):
1 Choose the View Show Entire Drive command.
2 You can sort by size, in descending order, to display the largest files on top; or sort by 

type to display files with the same extensions grouped together.
To remove the directory names from the file pane:
1 Choose the View Filter command.
2 Clear the Show Directories check box.
3 This option makes sense when the tree pane is displayed.



Selecting Files
There are several convenient ways to select (highlight) files in a file pane. Only the 
highlighted files are affected by commands such as File Delete and File Copy and by drag 
and drop operations.
Selecting with the mouse:
1 Click on a filename to select that file.
2 To extend the selection, press Shift while clicking.
3 To add one file to the selection, press Ctrl while clicking (this lets you select multiple files 

which are not next to each other).
Selecting with the keyboard:
1 Choose  and 
 to move the highlight, selecting one file.

2 To extend the selection, choose Shift+  and Shift+
.

3 To select non-contiguous files, first press Shift+F8. Use  and 
 to move the selection rectangle without selecting. Press Spacebar to select a file. Press 

Shift+F8 when finished selecting.
Selecting with menu commands:
* To select all files in the view pane, choose the File Select All command.
* To select all files matching one or more wildcards, choose the File Select Some 

command.
* To select all files except a few, first select the files you don't want, then choose the File 

Select Invert command.
* To select all files with a specific file a  ttribute  , first choose the View Filter command to 

display only files with that attribute, then choose the File Select All command.



Refresh: Updating the Drive Window
The information in a drive window can become out of date when the layout of your directory 
structure changes after the drive window was opened or when you insert a different diskette 
into a drive.
In order to show the directory tree quickly, Norton Desktop maintains a data file named 
TREEINFO.DT in the root directory of each disk. If, at the DOS prompt or using some file 
utility, you add, remove or rename directories, Norton Desktop is not aware of the changes. 
(Exception: changes made using the Norton Utility NCD are tracked automatically.)
Note: If you prefer, you can use expandable/collapsible trees which forces a disk read 

whenever tree information is needed. See Using Expandable/Collapsible Trees for 
details.

To force Norton Desktop to rescan the disk and display the updated tree structure, choose 
the View Refresh command.
Tip: To refresh the file pane quickly, just click on a different directory in the tree pane, then 

return to the original.



Drive Icons

Drive icons are graphical representations of each floppy, hard and network drive on your 
system. This also includes RAM, Bernoulli and CD-ROM drives. Having all drive icons on the 
desktop provides you with a quick and easy way to open a drive window and access the 
contents of the selected drive.
The Norton Desktop Configure Drive Icons command lets you choose which, if any, drive 
icons to display and where on the desktop to display them. You are not limited to displaying 
drive icons in a column on the side of your desktop--just drag them with the mouse to any 
location and their positions are saved as part of your desktop configuration.



Drive Window

Drive windows are used in Norton Desktop and the desktop tools such as UnErase and 
SuperFind to display and manipulate files and directories.
A drive window helps you to copy, move, delete and view files, organize your directories, 
launch programs and documents, and create Quick Access items.
To open a drive window, double-click a drive icon or choose the Window Open Drive 
Window command.



Button Bar

A button bar appears at the bottom of each drive window. You can customize every button 
on the button bar, if desired.
Choose the Configure Button Bar command to:
* Change the command that each button executes.
* Change the text displayed in a button.
* Disable or enable display of the button bar.



Drive Selector

Above the tree pane is a control which lets you select a different drive for display in the 
drive window.

Click the prompt button and select a drive.

Move the keyboard focus to drive selector control by pressing Tab. Type a drive letter ID or 
press Alt+  to display the drop-down list box.



File Pane

The file pane, in the upper right side of a drive window, displays file information for the 
directory selected in the tree pane. If more than one directory is selected, information for 
the last directory appears.
* You can drag files from a file pane into a directory in the tree pane, into another drive 

window, into a drive icon or onto any tool icon.
* To select multiple files, press Ctrl while clicking files.
* Speed Search: Type the first part of a filename to highlight the first match, then press  to

find other matches.
* To display multiple columns, choose the View File Details command and uncheck all
check boxes except Icon.
* Choose the View Filter command to display only the types of files desired.
* Choose the File Select Some command to highlight files matching a wildcard.



Tree Pane

The tree pane, at the left side of a drive window, displays a hierarchical representation of the
directories in the drive.
* Select a directory by clicking on it; its files are displayed in the file pane.
* Speed Search: Type the first part of a directory name to highlight the first match, then 

press  to find other matches.
* Choose the View Tree Pane command to enable or disable the tree display and leave 

more room for the file pane.
* Choose the View Refresh command to ensure that the tree display contains up-to-date 

directory information.
* Choose the Configure Drive Window command if you prefer an expandable/collapsible 

tree display.



View Pane

The view pane, at the bottom of a drive window, displays the contents of the file currently 
selected in the file pane.
* Choose the View View Pane command (or the View button) to enable or disable the 

view pane.
* Choose the View Viewer Find command to search for text.
* When viewing a spreadsheet or database file, choose the View Viewer Goto command 

to quickly find a cell.
* Choose the View Viewer Change Viewer command to view the file in a hex dump or 

alternate format.



File Attribute
Every file is associated with a set of on/off flags that describe certain traits of the file:
r Read only (can't be deleted or modified)
a Needs to be archived (hasn't been backed up)
s System (a DOS system file; usually hidden too)
h Hidden (not displayed from DOS DIR commands)

These attributes are displayed in the file pane. You can use the View Filter command to 
show only files with (or without) certain attributes. You can change attributes of file(s) via 
the File Properties command.



Wildcard
You can use wildcard characters to specify a set of files which share similar names. The 
wildcard characters are:
* any 1-to-8 character filename (or 0-to-3 character file extension)
? any single character

Examples:
*.* any filename and any extension
*.bak any filename with an extension of .BAK
*.? any file that has a 1-character extension
*. any file that has no extension
*.WK? any filename that has an extension that starts with .WK and then any other single

character
rpt??jul.* any filename starting with RPT, then any two characters, then JUL, and having 

any extension





File Extension
A file extension is the last part of a filename, consisting of a period and up to 3 characters. 
A file is fully identified by its drive ID, directory and name.    The file's name consists of a 
base portion (1 to 8 characters), a period, and the type (0 to 3 characters).
For example, in the filename AUTOEXEC.BAT, the extension is .BAT.





Three-State Check Box Control
A three-state check box has three possible states:

Gray-filled:    Ignore the attribute or condition.
Checked:    Include the file if the attribute or condition IS true.
Cleared:    Include the file only if the attribute or condition is NOT true.

Click the check box (or press Spacebar) until the check box is in the desired state.





Minimize and Maximize
When you click  the Minimize button (Alt+Spacebar,N) located near the top-right corner 
of a window, that window shrinks into an icon and appears at the bottom of your desktop.
You can double-click the icon to restore it to its previous size.
When you click  the Maximize button (Alt+Spacebar,X) located at the top-right corner of 
a window, that window instantly expands to fill the screen.
You can click  the Restore button to restore the window to its previous size.
Tip: You can also maximize or restore a window by double-clicking its title bar.





Tool Icons

Tool icons are displayed opposite your drive icons by default. However, they can be moved 
to any location on the desktop.
You can drag files from a drive window onto a tool icon to use that tool on a file or group of 
files.
You can double-click a tool icon to display its window for interactive use.
To remove a tool icon from your desktop, click it once and choose Close from its Control 
menu. Or, clear its check box in the Preferences dialog box of the Norton Desktop 
Configure menu.





‘‘Drag and Drop’’
This is a very useful file-handling technique supported by Norton Desktop for Windows. It 
lets you use the mouse to perform complex operations on-screen, with instant visual 
feedback.
Just select files and directories in a drive window and drag them (move the mouse while 
holding down the left mouse button) to a different location. The mouse pointer changes to a 
drag/drop cursor which indicates when and where it is possible to drop the files. Release the 
mouse button to complete the operation.
Some things that you can do with drag-and-drop might surprise you. For a complete 
discussion, see the help topic, 'Using Drag and Drop' in Help for Norton Desktop.



Drag/Drop Cursors
Norton Desktop provides visual feedback to help you perform drag-and-drop operations on 
files and desktop items. As you start dragging, the mouse cursor changes to one of the 
following:

You are dragging a file.
You are dragging two or more files.
You are dragging a directory.

You are dragging two or more directories.
While the cursor remains one of these, it means a drop is acceptable. As you drag the item, 
the cursor may change to:

Can't drop here.

Target is an application which will be launched to process the dragged object(s).


